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ΕΙΣΑΓΩΓΗ 
 

Ο λόγος για τον οποίο το οπλισμένο σκυρόδεμα επικράτησε το δημοφιλέστερο δομικό υλικό 

τόσο στη Κύπρο όσο και στο εξωτερικό είναι ότι συνδυάζει τα παρακάτω πλεονεκτήματα.  

 

• Είναι οικονομικό. Τα υλικά του (αδρανή, νερό, τσιμέντο) είναι φθηνά και 

προμηθεύονται εύκολα. Επιπλέον, κατά κανόνα δεν απαιτείται συντήρηση. 

 

• Είναι εύπλαστο και εύχρηστο. Το νωπό σκυρόδεμα μπορεί να προσαρμοστεί σε 

οποιαδήποτε μορφή ξυλοτύπου και να καλύψει σχεδόν όλες τις αρχιτεκτονικές 

απαιτήσεις. 

 

• Προσφέρεται για μονολιθικές κατασκευές, οι οποίες σαν πολλαπλά στατικά αόριστες 

έχουν μεγάλα περιθώρια αντοχής και ασφάλειας, ιδιαίτερα σε σεισμικές δράσεις. 
 

Ωστόσο, υπάρχουν και ορισμένα μειονεκτήματα του οπλισμένου σκυροδέματος τα οποία συχνά 

περιορίζουν τη χρήση του, όπως για παράδειγμα, 

 

• Έχει πολύ μεγάλο ίδιο βάρος, γεγονός που δημιουργεί προβλήματα κυρίως σε 

κατασκευές με μεγάλα ανοίγματα (π.χ. γέφυρες). Τα ογκώδη δομικά στοιχεία (δοκοί, 

υποστυλώματα) που απαιτούνται συχνά δυσχεραίνουν το πρόβλημα.  

 

• Το γεγονός ότι παρασκευάζεται επί τόπου αυξάνει τον κίνδυνο να παρουσιαστούν 

κατασκευαστικά ελαττώματα. 

 

• Σε περιπτώσεις βλαβών οι επισκευές είναι ιδιαίτερα δαπανηρές και δύσκολες στην 

εφαρμογή.  

 

• Οι θερμομονωτικές του ιδιότητες είναι περιορισμένες 

 

Ο σχεδιασμός και ο έλεγχος των στοιχείων από σκυρόδεμα απαιτεί από τον χρήστη να καθορίσει 

αρκετά μεγάλο αριθμό διαφόρων παραμέτρων. Το SCIA Engineer προκαθορίζει όλες αυτές τις 

παραμέτρους στις προεπιλεγμένες τιμές. Αυτές οι προκαθορισμένες τιμές μπορούν να 

χρησιμοποιηθούν για να ληφθούν εύλογα αποτελέσματα. Ωστόσο, τις περισσότερες φορές, ο 

χρήστης θέλει να ορίσει συγκεκριμένες διαφορετικές παραμέτρους σε διαφορετικά μέλη. Για την 

εκτέλεση αυτής της εργασίας μπορούν να χρησιμοποιηθούν τα στοιχεία των μελών. 

 

Ο σχεδιασμός αφορά κυρίως της όπλιση των στοιχείων (πλάκας, υποστηλώματα, δοκοί) 

αλλά και το μέγεθος και την απόσταση των οπλισμών (ραβδών) και των συνδετήρων, για κάθε 

στοιχείων που αναλύεται. Τα αποτελέσματα αυτά, είναι διαθέσιμα γραφικά αλλά και σε output 

tables και detailed reports. Τέλος, οι παράμετροι για το σχεδιασμό μπορούν να τροποποιηθούν 

για ολόκληρο το έργο ή μεμονωμένες στοιχείων στο πλαίσιο του σκυροδέματος. 
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Το θεωρητικό υπόβαθρο που χρησιμοποιείται για το σχεδιασμό στοιχείων από 

σκυρόδεμα σε κάμψη και διάτμηση, λαμβάνεται από  τις εσωτερικές δυνάμεις σε κάθε 

πεπερασμένο στοιχείο για τον προσδιορισμό των απαιτήσεων σχεδιασμού.  

 

 
 

• Design defaults beams / columns 

• General Setup 

• Design of beams 
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PROCESS FOR CALCULATION 

 

1. New Project 

File → New or Blank Project 

 

2. Project data 

Project data → Basic data → Material (Concrete) 
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2.1. Functionality  

 

1η Στήλη 2η Στήλη 

Climatic loads   √ Dynamics 
- Seismic spectral analysis   √ 

Dynamics   √ 

 

Subsoil 

- Pad foundation   √ 

- Soil Interaction √ 

Stability √ Steel 

-Steel connections   √ 

Structural model   √  
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2.2. Actions 

Loads → Wind load (according to code – για Κύπρο CY 24 m/sec – 40 m/sec – usually 30 m/sec) 

→ Snow load (according to code) 

→ Model factor - 1.30 

→ Seismic Combinations → Factor for concomitant components - 0.3 

→ OK! 

 

Σε περίπτωση που δεν είστε βέβαιοι πώς να δημιουργήσετε τους συνδυασμούς στους ''Code 

Combinations'' επιλέξτε ''Automatic''. 
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3. Κάνναβος 

 
Main → Line grid and storeys → 3D line grid  

→ Span Dr (X), Span Dr (Y)  Dr (Z)  → OK 

Στο παράθυρο εντολών (command window) γράψτε το '' 0 '' για να τοποθετήσετε το μοντέλο 
στους άξονες 0,0,0 UCS → Enter 
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➔ Τοποθέτηση καννάβου στο X,Y,Z 

➔ Για να κρυφτεί προσωρινά ο κάνναβος :   

 
 

 

 

Βοηθήματα για το View Parameters, Units και Member Properties μπορείτε να ακολουθήσετε το 

πιο κάτω σύνδεσμο. 

 

• https://www.youtube.com/watch?v=rUfvER8TQrM&index=10&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 
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3.1. Import CAD files: 

Main → Structure → Modelling / Drawings → Import DWG, DXF, VRML97. 

Or   

File → Import → IFC 2x3  
 

 
 

 

 

Import CAD Files 

 

• https://www.youtube.com/watch?v=Znp1-

OV7cOo&index=11&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 

 

Import IFC 

 

• https://www.youtube.com/watch?v=Wwa3TlAf9K4&index=12&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 
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3.2. Snap Settings  

 

 
 

 

Cursor Snap Settings 

 

• https://www.youtube.com/watch?v=WbH_KtSsD14&index=9&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 
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4. Layers 

➔ Για όλες τις διατομές και πλάκες ανά όροφο. 

 

Main → Tools → Layers 

 
 

 

Ta ‘’Layers’’ προσφέρονται για να 

μπορείτε να έχετε καλύτερο έλεγχο 

της κατασκευής. 

Επίσης, χρησιμεύει στην αυτόματη 

διαστασιολόγηση (Autodesign) 

γιατί μπορεί εύκολα να φιλτράρει 

τα μέλη μέσω των ‘’Layers’’. 

Η επιλογή ‘’Structural model only’’ 

σημαίνει ότι, τα μέλη που 

βρίσκονται σε αυτό/α τα ‘’Layer’’ 

που έχει αυτή την επιλογή, το 

SCIA Engineer δεν θα κάνει την 

ανάλυση του/των συγκεκριμένων 

μελών. 

Μόλις όμως ο χρήστης 

προχωρήσει σε ανάλυση το 

πρόγραμμα θα ειδοποιήσει εάν 

έχει κάνει αυτή την επιλογή. 
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5. Γεωμετρία 

 
Main → Libraries → Cross - sections 

 
Cross section → Πρόσθεση όλες των διατομών που θα χρησιμοποιηθούν στο σχεδιασμό του 
μοντέλου.  
 

 
 
 

 

Ο χρήστης μπορεί να 
χρησιμοποιήσει και το κουμπί των 
Cross-sections (Ctrl+J). 
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5.1. 1D Members 

Main → Structure → 1D member → Beam 

 

Main → Structure → Model data → Property Modifiers 1D  (0.5) 

For 1D members below ground (0 <) change ‘’Mass factor’’ to 0*. 

   

* ‘’Mass factor’’ has to be zero (0) because foundations and basements have no movement 

because according to codes they are non-sway members. 
 

  

 

 

 

  

Ο χρήστης μπορεί να επιλέξει 
από τη βιβλιοθήκη οποιαδήποτε 
διατομή επιθυμεί.  
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5.2. 2D Members 

Main → Structure → 2D member → Plates → Plate  

 

Main → Structure → Model data → Property Modifiers 2D (0.5) 

For 2D members below ground (0<) change ‘’Mass factor’’ to 0*. 

   

* ‘’Mass factor’’ has to be zero (0) because foundations and basements have no movement 

because according to codes they are non-sway members. 
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Για περισσότερες πληροφορίες όσον αφορά τον σχεδιασμό των διατομών μπορείτε να 
επισκεφτείτε το πιο κάτω σύνδεσμο. 
 

• Concrete cross-sections 

mailto:info@masesoft.com
https://help.scia.net/18.1/en/#rb/crosssections/introduction_to_concrete_cross_sections.htm?Highlight=concrete%20section
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Για να φαίνεται το κτήριο όπως θα είναι στη πραγματικότητα (Structural model) πατώ:  

 

Input of 1D members 

• https://www.youtube.com/watch?v=39k0M9176ic&index=5&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 

 

Για να σπάσει μια δοκός θα πρέπει ο χρήστης να επιλέξει τη δοκό και με την εντολή “Break 
in defined points” να επιλέξει τους κόμβους στο σημείο που επιθυμεί να σπάσει και μετά Esc 
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6. Στηρίξεις  

➔ Για θεμελίωση άκρων των κολώνων / δοκών επιλέγεται πάκτωση   

➔ Για τους κόμβους: Structure → Model data → Support → In node  

 

 

 

Main → Structure → Model data → Hinge on beam (i.e change fix or/and fiz to free) 

Αυτό γίνεται συνήθως όταν υπάρχουν κάποιες δευτερεύουσες δοκοί οι οποίες κατά την 

γνώμη του Πολιτικού Μηχανικού δεν μεταφέρουν π.χ. ροπές, κάμψης κτλ. 

 

Input of Supports 

• https://www.youtube.com/watch?v=EG8XWmtsp8g&index=8&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW  

 
6.1. Section on beam 

Main → Structure → Model data → Section on beam 
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7. Connect Members   

Main → Calculation, mesh → Connect members/ nodes   

 
8. Έλεγχος Γεωμετρίας 

 

Structure → Check structure data → Check → Continue → OK 

Αυτό γίνεται πάντα μετά από την σύνδεση των μελών (Connect members/nodes) για να δούμε 

τυχόν διπλές ονομασίες, ασύνδετα μέλη και γενικά προβλήματα του στατικού μας φορέα. 
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9. Load Cases  

 
Main → Load Cases  
(Selfweight, Dead, Dead Partitions, Dead Roof, Live, Live Roof, 3D wind)  
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Τα ‘’Load group’’ για 

τα ‘’Self weight’’ και 

για τα ‘’Dead loads’’ 

δημιουργούνται 

αυτόματα. 

 

Για τα ‘’Live loads’’ 

πρέπει ο χρήστης να 

επιλέξει πατώντας τις  

τελείες για να 

δημιουργήσει ένα νέο 

‘’Load group’’ με την 

κατηγορία που 

επιθυμεί π.χ.  

Cat A: Domestic 

δηλαδή κατοικίες.  

Eurocode 0, Annex 

A1, table A1.1. 
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Δεν έχουν οριστεί ακόμη τα σεισμικά ‘’Load cases’’, γιατί η κατασκευή δεν έχει φορτίσει με 

τα μόνιμα φορτία (Dead loads) και τα κινητά φορτία (Live loads) τα οποία θα δώσουν τις 

σεισμικές μάζες (Mass Groups / Combination of mass groups) και άρα τα σεισμικά ‘’Load 

cases’’. 

 

Creation of Load Groups and Cases 

 

• https://www.youtube.com/watch?v=CdtFbUKsMPA&index=13&list=PL0OvQw2kgGq6R

gBwrQj7cx0kCskBg5FCW 

 

Creation of Load Combinations 

 

• https://www.youtube.com/watch?v=p6CH4Mini-

A&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW&index=14 
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10. Loads  

10.1. Dead Loads 

 

Loads → Dead → Surface load → On 2D member 

Οι φορτίσεις εισάγονται αναλόγως της κατασκευής. 
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10.2. Live Loads  

 

Loads → Live → Surface load → On 2D member  

Τα κινητά φορτία εισάγονται σύμφωνα με το παράρτημα της κάθε χώρας! ΑΝ επιθυμείτε 

μπορείτε να τα αυξήσετε. 

Στην Κύπρο: 

Πλάκες (βατές): 2 kN/m2, Πλάκες (Μη βατές): 0.4 kN/m2 

Κλιμακοστάσια: 3 kN/m2 

Πρόβολοι: 4 kN/m2 

 

 

3D Wind Load Generator 

https://www.youtube.com/watch?v=6JLwonXonWw&list=PL0OvQw2kgGq6RgBwrQj7cx0k

CskBg5FCW&index=16 

 

Input of Free Surface Loads 

https://www.youtube.com/watch?v=7qkUG7B-

Jdc&index=17&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 

 

Creation of Basic Loads 

https://www.youtube.com/watch?v=iSaQG7Lgl1w&index=15&list=PL0OvQw2kgGq6RgBwrQj7

cx0kCskBg5FCW 
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11. Connect Members/nodes  

 

Structure → Model data → Connect members / nodes → Check  → Yes   

 

Πριν να γίνει η ένωση των κόμβων πρέπει να σιγουρευτείτε για τη γεωμετρία. Αν προκύψει 

οποιαδήποτε αλλαγή θα πρέπει να ξαναγίνει η σύνδεση των κόμβων. Επίσης, αν ο χρήστης 

πρόκειται να μετακινήσει κάποιο κόμβο ή μέλος πρέπει να τα αποσυνδέσει (Disconnect 

members/nodes) γιατί θα μετακινηθούν και τα υπόλοιπα μέλη που είναι συνδεδεμένα μεταξύ 

τους. 
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12. Mesh generation   

 Πρέπει να γίνει αμέσως μετά που θα φορτιστεί η κατασκευή, για να μεταφερθούν τα φορτία 

σωστά και να μπορέσουν μετά να δημιουργηθούν οι σεισμικές μάζες. 

 

Intro to Mesh Setup & Generation 

 

• https://www.youtube.com/watch?v=CBs068SBH1Y&list=PL0OvQw2kgGq6RgBwrQj7cx

0kCskBg5FCW&index=20 

 

 
13. Mass Groups  

Main → Dynamics → Mass groups (Selfweight, Dead, Live, etc.) 
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14. Combination of Mass Groups  

 

Main → Dynamics → Combination of mass groups → Add All → OK 

➔ MG3 = Live Load → Coeff.= 0.3 (70% απομείωση)  

➔ Για ‘’Dead’’ και ‘’Live’’ φορτία κάτω από την επιφάνεια (συμπεριλαμβανομένου το 

ισόγειο) ΔΕΝ προστίθενται στο ''’Combination of mass groups'' επειδή οι μάζες κάτω 

από την επιφάνεια του εδάφους ΔΕΝ υπολογίζονται. 

➔ Στα ‘’Live’’ φορτία για σεισμικό συνδυασμό πάνω από το έδαφος → Used Coeff. = 

0.3  

➔ Code: ΨΕi = φ x ψ2i = 0.3 (Residential φ = 1, ψ2 = 0.3) - Table A1.1 + A1.2(B) (CYS) 
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Αυτό γίνεται για όλες τις μάζες εκτός από τα ‘’Free load’’ τα οποία δεν συμπεριλαμβάνονται εδώ. 
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15. Seismic X 

Main → Load cases → New → Seismic X 
 
Δημιουργήστε μια νέα ομάδα φορτίων LG4 (Together And Seismic)  

Main → Dynamic → Seismicity → Check the direction X 
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16. Seismic spectrums  

Libraries  → Loads → Seismic spectrums (q-factor) 
➔ Type drawing → Period 

➔ Info short → Eurocode 

 

Edit → Code parameters  
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➔ Code parameters   

➔ Coeff. accel. ag (AgR)= AgR * γi= 0.25 * 1= 0.25 

➔ ag – design acceleration= 0.25 * 9.81= 2.453 m/s2 

➔ q factor= 2 

➔ beta= 0.20 

➔ Subsoil= C 

➔ Spectrum type= Type 1 

➔ Direction= Horizontal  

 

➔ To γi τροποποιείται ανάλογα σε ποια κατηγορία σπουδαιότητας είναι το κτήριο.  

 

Κατηγορίες Σπουδαιότητας (γi) 

Κατηγ. Ι (Φάρμες) 0.8 

Κατηγ. ΙΙ (Κατοικίες) 1.0 

Κατηγ. ΙΙΙ (Σχολεία κλπ) 1.2 

Κατηγ. ΙV (Νοσοκομεία κλπ) 1.4 
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Κατά τον Ευρωκώδικα 8 (σε κτίρια) η κατακόρυφη συνιστώσα χρειάζεται να λαμβάνεται υπ' όψη 
εάν η μέγιστη κατακόρυφη επιτάχυνση avg, είναι μεγαλύτερη από 0,25g δηλαδή, στη Ζώνη  
Επικινδυνότητας 2 = 0.20 (μόνο για την γi = ΙV), καθώς και στην Ζώνη  Επικινδυνότητας 3 = 0.25 
μόνο για τις κατηγορίες σπουδαιότητας (γi = III και ΙV), αλλά και πάλι μόνο στις ακόλουθες 
περιπτώσεις: 
 
– για (σχεδόν) οριζόντια μέλη με άνοιγμα τουλάχιστον 20m 
– για (σχεδόν) οριζόντιους προβόλους με άνοιγμα μεγαλύτερο από 5m 
– για (σχεδόν) οριζόντια προεντεταμένα μέλη 
– για δοκούς που στηρίζουν φυτευτά υποστυλώματα 
– σε κτίρια με σεισμική μόνωση. 
 
Για την παρούσα μελέτη ισχύει avg = AgR*γi*0.9 = 0.9*1*0.25g = 0.225g < 0.25g.  
 
Άρα δεν θα ληφθεί υπόψη η κατακόρυφη συνιστώσα του σεισμού στη μελέτη της υπ' όψη 
κατασκευής θεωρώντας ότι η επιρροή της καλύπτεται από τους συντελεστές ασφαλείας γg=1,35 
και γq=1,50 στον συνδυασμό βασικών δράσεων χωρίς σεισμό, και από τα υφιστάμενα 
περιθώρια αξονικής αντοχής των κατακόρυφων στοιχείων.  
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17. Load  - CQC 

➔ Load cases → SEISMIC X → Modal Superposition → Type of superposition → CQC 
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➔ Edit  

➔ Frequency 10000 (έλεγχος σε ευρύ φάσμα συχνοτήτων) 

➔  Damping (ξ) 3% - 5% (Concrete, Steel, Timber) 
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18. Combinations  

 
➔ List of load cases → Combinations → Insert → Add ( Selfweight / Dead / Live) 

➔ Name – SLS 

➔ Type – EN-SLS characteristic → Yes → OK 

 

➔ ULS Set B, ULS Set C with SW, DL, LL loads and with Wind load cases 

➔ Name – ULS Set B 

➔ Type – EN-ULS Set B → Yes → OK 

 

➔ Name – ULS Set C 

➔ Type – EN-ULS Set C → Yes → OK 

 

➔ Name – Seismic X (0.3Y) Απομειώση σεισμού στο Υ κατά 70% 

➔ Type – EN-Seismic → Yes → OK 

 

➔ Name – Seismic Y (0.3X) Απομειώση σεισμού στο Χ κατά 70% 

➔ Type – EN-Seismic → Yes → OK 
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Τα ‘’Load cases’’ για τον 

άνεμο δημιουργούνται 

αυτόματα και ο χρήστης 

πρέπει να τα εισάγει εδώ, 

δηλαδή στον συνδυασμό 

‘’ULS’’ γιατί ο κανονισμός μας 

επιτρέπει να ΜΗΝ έχουμε δυο 

(2) τυχηματικές δράσεις να 

εισάγονται μαζί στην ανάλυση 

μας (Άνεμος και Σεισμός μαζί). 

Αυτό είναι εφικτό γιατί είναι 

αρκετά σπάνιο γεγονός να 

συμβούν ταυτόχρονα. 

 

To SCIA Engineer δημιουργεί 

αυτόματα όλες τις διευθύνσεις 

ανέμου που θα επηρεάσουν 

το κτίριο μου οι οποίες θα 

φαίνονται στην δεξιά λίστα 

‘’List of load cases’’. 
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• Combinations containing seismic load cases 
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19. Result classes  

 

Main → Load case → Result classes  

 

➔ SLS 

➔ ULS 

➔ RC1 (SEISMIC) → είναι μια περιβάλλουσα συνδυασμών 

➔ GEO (ULS Set C) 

 

 

 

Χρειάζεται προσοχή όταν αναλύεται μια κατασκευή με δυναμική φόρτιση στο SCIA Engineer έτσι 

η MASES SOFTWARE προτείνει να δείτε την παρακάτω ιστοσελίδα της SCIA. 

 

• Dynamic analysis troubleshooting  
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20. CALCULATION 

 

20.1. Calculation  

Main → Calculation/ Mesh → Calculation  

 

 

Running an Analysis, Check Structure Data and Connect Nodes/Members 

 

• https://www.youtube.com/watch?v=aq1S51ebBtw&list=PL0OvQw2kgGq6RgBwrQj7

cx0kCskBg5FCW&index=21 
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20.2. Mesh setup 

 

Main → Calculation / Mesh → Mesh setup  

Δείχνει σε πόσα μέρη θα γίνει η ανάλυση των πεπερασμένων στοιχείων. 

 

Αν ο χρήστης επιθυμεί το πρόγραμμα να το κάνει αυτόματα τότε: Advanced mesh settings → 
Automatic .  Πρέπει όμως να επιλέξει ‘’Load cases’’. 

 

• https://resources.scia.net/en/articles/analysis/15_3_automatic_mesh_refinement_impro

vement.htm 

 

Automatic mesh refinement in SCIA Engineer 16 

 

• https://www.youtube.com/watch?v=P5RoDSnMGy0 

 

 

 

➔ Average number of tiles of 1D element → 4  

➔ Average size of 2D element/curved element → 0.25 (0.20 - 0.30) 

 

Το μέγεθος του πλέγματος (mesh) του επιφανειακού πεπερασμένου στοιχείου (2D member) 
εξαρτάται από το πάχος του και πόσο πυκνό το θέλει ο μελετητής. 
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20.3. Solver setup 

 

Main → Calculation/ Mesh → Solver setup 

- Number of eigenmodes → 30 

 

Το IRS χρησιμοποιείται όταν το μοντέλο είναι τουλάχιστον 2 ορόφων και άνω. 

Το IRS προτείνει τον ακριβή αριθμό ιδιομορφών (eigenmodes) !!! 

 

• http://masesoft.com/seismic-design.html 

 

 

 

Σε περίπτωση που ο χρήστης αντιμετωπίζει λάθη στο μοντέλο, υπάρχουν τα βοηθήματα 

(help.scia.net): 

 

• IRS: Too many eigen values requested / Non-associated R-node detected 

 

• Issue: incorrect sum of masses 

 

• Issue: total base shear is not the sum of modal values 

 

 

 

 

 

 

 

 

 

mailto:info@masesoft.com
http://masesoft.com/seismic-design.html
https://help.scia.net/18.1/en/
https://help.scia.net/18.1/en/index.htm#sr/seismic_analysis_of_buildings/irs_non_associated_r-node.htm%3FTocPath%3DTheoretical%2520background|Dynamics|Dynamics%2520troubleshooting|Dynamic%2520analysis%2520troubleshooting|Troubleshooting|_____1
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/issue_mass_does_not_match_hand_calc.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CTroubleshooting%7C_____2
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/issue_base_shear_sum.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CTroubleshooting%7C_____3


44 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

  
 

20.4. Calculation protocol 

 

Main → Results → Calculation protocol → Type: Eigen frequency → Preview 

• http://masesoft.com/seismic-design.html 
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Πρώτα γίνεται μια φασματική ανάλυση ούτως ώστε ο χρήστης να μπορεί να δει την 

συμπεριφορά του κτηρίου και εφόσον είναι ικανοποιημένος τότε μπορεί να προχωρήσει σε 

γραμμική και δυναμική ανάλυση (Linear Analysis) για έλεγχο πλέον του στατικού φορέα.  

• Validation of modal analysis: mode shapes 

 

• Validation of modal analysis: relative modal masses 

  

mailto:info@masesoft.com
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/validation_modal_analysis_mode_shapes.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CValidation%2520of%2520modal%2520analysis%7C_____2
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/validation_modal_analysis_modal_masses.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CValidation%2520of%2520modal%2520analysis%7CCalcula


46 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

  
 

21. RESULTS 

 

21.1. Linear Analysis 

Run LINEAR Analysis ONLY (Συμπεριλαμβάνεται και τον σεισμό!) 
 
➔ Results  

 

21.2. Displacement of nodes  

 

 

Ο χρήστης μπορεί να επιλέξει κάποιους κόμβους (nodes) της επιλογής του για να παρατηρήσει 

την μετατόπιση τους (Displacement), αλλιώς το πρόγραμμα θα δώσει αποτελέσματα 

μετατοπίσεων όλων των κόμβων του κτιρίου. 
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21.3. 3D displacement 

Main → Results → 3D displacement  

  

 

Main → Results → 3D displacement → Wireframe  

Με την εντολή Wireframe, παρουσιάζεται το κτήριο σε γραμμική μορφή. 

 

 

Παρατηρείται ότι η μεγαλύτερη μετακίνηση είναι στο άκρο της πλάκας του κτηρίου, με μετακίνηση 

που κυμαίνεται από 2.8 έως 3.3 χιλιοστά (mm)!   
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21.4. 3D stress 

 

 
21.5. Reactions 

Main → Results → Supports → Reactions 
 

 

 

Με την εντολή ‘’Type of Loads’’  γίνεται επιλογή ‘’Load cases’’, αν όμως εμφανίζεται αστεράκι (*) 

δίπλα από τα ‘’Load cases’’ (δλδ, Load cases*) τότε το πρόγραμμα δεν έχει τρέξει σε ‘’Linear 

Analysis’’ αλλά μόνο σε ‘’Modal Analysis’’ (Μόνο φασματική).  

• https://www.youtube.com/watch?v=MAL0ia01zIY&index=22&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 
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21.6. Beams 

21.6.1. Internal forces of beam 

Main → Results → Beams → Internal forces of beam  

(Συμπεριλαμβαν Columns and Beams) 

 

Επιλέχθηκαν κάποια στοιχεία δοκών ή/και κολώνων. Στην επιλογή ‘’Selection’’ → ‘’Current’’ για 

να αναλύσει τα επιλεγόμενα στοιχεία αλλιώς η επιλογή ‘’All’’ δίνει όλες τις εσωτερικές δυνάμεις 

των στοιχείων. Επίσης, στην επιλογή ‘’Extreme’’ αν επιλεχθεί το ‘’Global’’ εμφανίζονται τα 

δυσμενέστερα αποτελέσματα ενώ αν επιλεχθεί το ‘΄ Member” παρουσιάζονται τα αποτελέσματα 

όλων των επιλεγμένων στοιχείων.  
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21.7. Deformations of beam 

Main → Results → Beams → Deformations of beam  

 

 

 

Στη περίπτωση αυτή, επιλέχθηκαν κάποιες από τις κολώνες (κατ’ επιλογή), έτσι παρατηρείται η 

παραμόρφωση των επιλεγμένων στοιχείων. Στην περίπτωση ‘’Global’’ εμφανίζονται μόνο οι 

δυσμενέστερες μετατοπίσεις (SLS). 
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21.8. Member Stress  

 
Main → Results → Beams → Member Stress  
 
Εδώ ‘’Selection’’ → ‘’All’’ φαίνεται η ολική συμπεριφορά του κτιρίου, ενώ στη δεύτερη εικόνα 
παρουσιάζονται τα αποτελέσματα των στοιχείων που επιλέχθηκαν να αναλυθούν.  

 

 

21.9. Acceleration of nodes  

  
Main → Results → Dynamics → Acceleration of nodes  
 

 

 

Type of Loads → Mass combinations  

Mass combinations – για παράδειγμα  CM 1/3 – 13.26 παρατηρείται στο συγκεκριμένο κόμβο 

(node) τι συμβαίνει - πως αντιδρά.  
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21.10.  2D members  

21.10.1. Displacement of nodes 

 
Main → Results → 2D members → Displacement of nodes 
 

 

 
 
21.11.  Internal Forces  

Main → Results → 2D members → Internal forces 
 

 
 

Η πλάκα του πιο πάνω μοντέλου έγινε με ‘’Plate” από οπλισμένο σκυρόδεμα.  

Αν ο χρήστης επιθυμεί η πλάκα να είναι από Ο/Σ θα πρέπει να συνυπολογιστεί επιπλέον 

στο συνολικό βάρος με επιπρόσθετα φορτία των μόνιμων π.χ. βάρος 10cm πλάκας= 

2,5kN/m2 + 3 kN/m2 (μόνιμα). 

21.12. Stresses / Strain 
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Main → Results → 2D members → Stresses / Strain 
 

 

 

21.13. Bill of material  

Main → Results → Bill of material (Estimation of quantities) 
 

 

Στη περίπτωση αυτή υπολογίζεται το βάρος του κάθε υλικού σε όλη τη κατασκευή.  

Αν θα έχουμε πλάκα από Ο/Σ θα πρέπει ΠΡΩΤΑ να γίνει η ανάλυση ή το ‘’Mesh generation’’. 

 

  

mailto:info@masesoft.com


54 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

  
 

Intro to Results on Supports 

• https://www.youtube.com/watch?v=MAL0ia01zIY&list=PL0OvQw2kgGq6RgBwrQj7cx

0kCskBg5FCW&index=22 

 

 

Results on 1D Members 

• https://www.youtube.com/watch?v=f5jCcqoIc1s&list=PL0OvQw2kgGq6RgBwrQj7cx0

kCskBg5FCW&index=23 

 

 

Results on 2D Members 

• https://www.youtube.com/watch?v=BMDFyMhXgck&list=PL0OvQw2kgGq6RgBwrQj7

cx0kCskBg5FCW&index=24 

 

 

3D Results 

• https://www.youtube.com/watch?v=yaaNZhCITnA&index=25&list=PL0OvQw2kgGq6

RgBwrQj7cx0kCskBg5FCW 

 

 

Intro to Story Results 

• https://www.youtube.com/watch?v=vSTN9OyqS-

Q&index=26&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 
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22. CONCRETE DESIGN  

 

22.1. Concrete Reinforcement Design  

Main → Concrete  →  Reinforcement Design → Design defaults 
 

 
 

22.2. Reinforcement Design 

Main → Concrete  → Reinforcement Design → 1D member → Reinforcement Design 

Με την επιλογή ‘’Reinforcement Design’’, ο χρήστης επιλέγει τις κολώνες/ δοκούς και το 
πρόγραμμα εμφανίζει το θεωρητικό οπλισμό που χρειάζονται τα στοιχεία που επιλέχθηκαν. Με 
τον τρόπο αυτό, ο χρήστης γνωρίζει το οπλισμό που πρέπει να ορίσει στο πρόγραμμα στο βήμα 
’’Reinforcement input + edit → New Reinforcement’’.  
 

ΠΡΟΣΟΧΗ μέχρις στιγμής ο οπλισμός είναι θεωρητικός ! 
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22.3. Reinforcement input + edit  

Main→ Reinforcement input + edit → 1D Members → New Reinforcement 
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22.4. Reinforcement input + edit → 1D Members 

 
Main → Reinforcement input + edit → 1D Members → New Stirrups 
 

Γίνεται επιλογή ενός στοιχείου π. χ κολώνας, από κόμβο σε κόμβο (αρχή και τέλους κολώνας), 

ούτως ώστε το πρόγραμμα να καταλάβει τους κόμβους αρχής και τέλος για να τοποθετήσει τους 

συνδετήρες σωστά. Αφού τοποθετηθούν οι συνδετήρες, για τυχόν επεξεργασία, ο χρήστης 

επιλέγει τους συνδετήρες και από την εντολή ‘’Diameter’’ έχει την ευκαιρία να αλλάξει τη διάμετρο 

των συνδετήρων, ή και την απόσταση μεταξύ των συνδετήρων από την εντολή “Stirrups 

distance’’. 

 

 

 
 

 

22.5. Free bars 

Main → Reinforcement input + edit → 1D Members → New Stirrups 
 

Όταν εισαχθεί μια ελεύθερη μπάρα, αντιπροσωπεύει μια αυτόνομη οντότητα που δεν έχει καμία 

σχέση με κανένα από τα καθορισμένα δοκάρια, στήλες, πλάκες κ.λπ. στο μοντέλο. Είναι 

απαραίτητο να τοποθετήσετε τη μπάρα στα απαιτούμενα μέλη. 
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23. FOUNDATION DESIGN 

 
Το SCIA Engineer διαθέτει ενσωματωμένο εργαλείο για πλήρη έλεγχο θεμελιώσεων σύμφωνα 
με τον EC7. 
 
23.1. ΓΕΝΙΚΗ ΚΟΙΤΟΣΤΡΩΣΗ 

 

Η θεμελίωση με γενική κοιτόστρωση εφαρμόζεται κυρίως όταν το έδαφος δεν είναι πολύ 

ανθεκτικό - ασταθές έδαφος. Η λειτουργία της κοιτόστρωσης μοιάζει με τη λειτουργία μίας 

σχάρας πεδιλοδοκών. 

Στη γενική κοιτόστρωση οι ισχυρότερες τάσεις που δημιουργούνται είναι στην περιοχή των 

υποστυλωμάτων και οι ασθενέστερες τάσεις στις ενδιάμεσες περιοχές. Όταν υπάρχουν 

δοκοί ενίσχυσης, τότε οι τάσεις στο έδαφος έχουν μικρότερη απόκλιση μεταξύ των περιοχών 

των υποστυλωμάτων και των ενδιάμεσων περιοχών της κοιτόστρωσης. 

 

 

23.1.1. 2D Members → Plates  

 

Main → Structure → 2D Members → Plates → Plate (Concrete) 
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23.1.2. Support  

 

Main → Structure → Model data → Support → Surface (el. Foundation) 
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23.1.3. Connect members / nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes 
 
 

23.1.4. Calculation/ Mesh  

Main → Calculation/ Mesh → Calculation  
 
 

23.1.5. Reinforcement design  

Main → Concrete → Reinforcement input + edit → Reinforcement 2D 
 
Με την επιλογή ‘’Reinforcement 2D’’ ο χρήστης επιλέγει το ‘’plate’’ που ορίστηκε και εμφανίζεται 
παράθυρο στο οποίο μπορεί να θέσει τους οπλισμούς της επιλογής του, της αποστάσεις κλπ.  
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ENGINEERING REPORT 

 
23.2. Engineering report 

Main → Engineering report 
 

Μέσω του Engineering Report εισάγονται όλα τα δεδομένα που 
σχετίζονται με τη μελέτη, επεξηγούνται οι λεπτομέρειες της μελέτης 
που κυμαίνονται από προσδιορισμό των δεδομένων της μελέτης στα 
στατικά αποτελέσματα της ανάλυσης, εισάγονται όλοι οι έλεγχοι 
σχεδιασμού του κτηρίου αλλά και τα σχέδια μελέτης που μπορεί 
εύκολα τόσο ο μελετητής όσο και η ομάδα αποπεράτωσης του έργου 
να τα αντιληφθεί.  
 
Επιπλέον, εύκολα μπορούν να ομαδοποιούνται δεδομένα της 
μελέτης και να εισάγονται εικόνες που αντιστοιχούν στα δεδομένα 
αυτά.  
 
Με την εντολή ‘’Engineering Report’’ ανοίγει παράθυρο στο οποίο 
με την εντολή ‘’New’’, μεταφέρεται στο report για αν το 
επεξεργαστούμε.   
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Διπλό κλίκ για να ανοίξει το 
παράθυρο του report και να το 
επεξεργαστούμε.   
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Main → Engineering report → Insert  
 
 

 
 
 
Στα αριστερά του παραθύρου εμφανίζονται όλες οι επιλογές που παρέχονται από το πρόγραμμα 
ούτως ώστε να εισαχθούν ότι θεωρείται από τον Μηχανικό απαραίτητο και σημαντικό για το 
report.  
Πιο κάτω φαίνονται κάποιες από τις επιλογές και πως χρησιμοποιούνται.  
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Special items → Head and Footer  
  → Table of Contents  
  → Page Break 
  → Chapter → Properties → General 
 
Libraries →Material  
    → Cross section 

   → Subsoils 
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Από εντολή ‘’Regenerate’’, και με τη χρήση του προγράμματος Scia Engineer, δεξί κλικ 
εμφανίζεται το πιο κάτω. 
Με την εντολή ‘’Live Picture in scale into Engineering report’’, προστίθεται η εικόνα του μοντέλου 
στο ‘’Engineering report’’.  
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23.3. Nodes, Member, 2D member 

 
Main → Engineering report → Structure 
 
Για να ενταχθούν τα χαρακτηριστικά των μελών, κόμβων κ.λπ. (Nodes, Member, 2D member 
etc) στο ‘’Engineering report’’, επιλέγουμε την εντολή ‘’Structure’’  → Nodes 
                           → Member  
                           → 2D Member  
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23.4. Loads  

 
Main → ’’Engineering report’’ → ‘’Sets’’ προθέτονται τα ‘’Load Cases’’ στο engineering report.  
Για να εμφανίζεται εικόνα των ‘’Load Cases’’, πηγαίνουμε στο πρόγραμμα ‘’Main → Load’’. 
 
Από εντολή ‘’Regenerate’’, και με τη χρήση του προγράμματος Scia Engineer, δεξί κλικ 
εμφανίζεται το πιο κάτω. Με την εντολή ‘’Live Picture in scale into Engineering report’’, 
προστίθεται η εικόνα του μοντέλου στο ‘’Engineering report’’.  
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23.5. Results  

 
Για να προστεθούν τα αποτελέσματα του μοντέλου από το πρόγραμμα SCIA Engineer, 
ακολουθούνται τα παρακάτω βήματα.  
 
Main →Engineering Report → Report Template → System templates → 1D 
Internal forces 
 
Με την επιλογή ‘’1D Internal forces’’, παρουσιάζονται οι φορτίσεις (αξονικές, 
ροπές) της κατασκευής. 
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Πιο κάτω παρουσιάζεται ένας τυπικός πίνακας περιεχομένων. Είναι στην επιλογή του 
Μηχανικού τι θέλει να παρουσιάζεται στο πίνακα περιεχομένων. 
 

 
 

 
Περισσότερες πληροφορίες όσον αφορά το Engineering Report μπορείτε να επισκεφτείτε τους 
πιο κάτω συνδέσμους.  
 

• Scia Engineer - Report templates 

• SCIA Design Forms sheets 

• Properties of a report 

 
 
 

 
 

mailto:info@masesoft.com
https://help.scia.net/18.1/en/#tum/engineeringreport/report_templates.htm?Highlight=engineering%20report%20template
https://help.scia.net/18.1/en/#tum/engineeringreport/sdf_in_er.htm?Highlight=engineering%20report%20template
https://help.scia.net/18.1/en/#tum/engineeringreport/document_properties.htm?Highlight=engineering%20report%20template

